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Avogadro	is	a	free,	open	source	molecular	editor	and	visualization	tool,	designed	for	use	on	Mac,	Windows,	and	Linux	in
computational	chemistry,	molecular	modeling,	bioinformatics,	materials	science,	and	related	areas.	It	offers	flexible	high
quality	rendering	and	a	powerful	plugin	architecture.

More	about	Avogadro,	including	development	details	and	downloads	can	be	found	at	http://avogadro.cc

This	book	would	not	be	possible	without	the	help	and	effort	of	many	people,	including	Avogadro	developers,	translators,
and	users	world-wide.

Funding	for	the	Avogadro	manual	was	provided	by	the	University	of	Pittsburgh	Department	of	Chemistry.

-Taylor	Cornell	and	Geoffrey	Hutchison

Summer	2015

Pittsburgh,	Pennsylvania

Avogadro:	Molecular	Editor	and	Visualization

Thanks
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Avogadro	is	a	"molecular	editor,"	designed	to	be	easy	to	use	to	construct	and	view	molecules	and	materials	in	3D.	It	runs
on	Windows,	Linux,	and	Mac.

This	manual	was	largely	made	on	a	Mac,	but	the	interface	should	be	very	similar	on	any	computer.

When	you	initially	open	Avogadro	you	will	be	presented	with	a	screen	such	as	the	one	shown	below.

The	first	thing	you	will	probably	want	to	do	is	open	a	file	and	navigate	around	the	molecule.	To	do	this	click	on	the		File	
menu	and	select		Open...	.

Introduction

Opening	a	File

Learning	Avogadro	-	The	Molecular	Editor

5Introduction



You	can	then	look	through	the	files	on	your	disk	and	find	an	appropriate	chemical	file.	Thanks	to	Open	Babel,	a	large
number	of	file	types	are	supported	including	CML,	XYZ,	SDF,	Mol2,	PDB	etc.	Several	example	molecules	are	supplied	with
Avogadro.

The	screen	shot	above	shows	the	ethanol.cml	file	opened	up	and	displayed	using	the	default	Ball	and	Stick	display	type.
Notice	that	when	a	new	file	is	opened	Avogadro	switches	from	the	Draw	Tool	to	the	Navigate	Tool,	which	allows	you	to	view
the	molecule	without	editing	it.

You	can	zoom	in/out	using	the	scroll	wheel	on	your	mouse	or	holding	down	the	middle	mouse	button	and	moving	the
mouse	cursor	up/down.	You	can	rotate	the	view	by	holding	down	the	left	mouse	button	and	moving	the	mouse	cursor.	You
can	also	translate	the	view	by	holding	down	the	right	mouse	button	and	moving	the	mouse	cursor.

Note:	if	your	mouse	only	has	one	or	two	buttons	you	can	also	use	the	modifier	keys	(shift	and	control)	along	with	the	left
mouse	button	to	perform	actions	where	you	would	normally	use	the	middle	or	right	mouse	buttons	respectively.

Navigation
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Molecules	can	be	built	and	edited	with	the	draw	tool.

You	can	begin	creating	a	molecule	by	left	clicking	on	the	black	display.	This	will	generate	a	carbon	atom.	Right	clicking	on
the	atom	will	delete	it.

Left	clicking	and	dragging	the	mouse	will	generate	a	bond	to	another	carbon	atom.

Drawing	Molecules

Creating	a	Molecule
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Different	elements	can	be	selected	from	the	Element	drop	down	menu.	Typing	the	atomic	symbol	(e.g.,	"A-s"	for	Arsenic)	is
a	shortcut	for	changing	the	selected	element.

For	example,	if	you	wanted	to	create	water,	you	can	type	in	"O",	or	select	"Oxygen	(8)"	from	the	drop	down	menu	and	click
on	the	black	display.
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If	the	"Adjust	Hydrogens"	box	is	checked,	hydrogens	in	the	molecule	are	automatically	adjusted	to	satisfy	valency	(as
shown	above).

Bond	order	can	be	changed	through	the	Bond	Order	drop	down	menu,	or	by	typing	the	numbers	"1",	"2",	or	"3".	Bonds	can
also	be	added	to	a	molecule	by	left	clicking	on	a	bond	that	has	already	been	created	(this	process	cycles	through	single,
double,	and	triple	bonds).	Right	clicking	on	a	bond	will	delete	the	bond,	and	the	atom	it's	bonded	to.
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For	example,	to	create	carbon	dioxide,	the	general	structure	("O-C-O")	needs	to	be	drawn,	and	then	by	left	clicking	the
bonds	in	the	molecule,	double	bonds	will	be	created.
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Under	the	"Extensions"	menu,	the	geometry	of	a	molecule	can	be	optimized	by	selecting	"Optimize	Geometry".

You	now	know	the	basics	on	drawing	a	molecule!
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The	selection	tool	allows	the	indiviual	selection	of	atoms,	bonds,	or	fragments.

There	are	three	types	of	selection	modes:	"Atom/Bond",	"Residue",	and	"Molecule".

The	"Atom/Bond"	selection	mode	provides	you	with	the	ability	to	select	a	single	atom	within	a	molecule.	This	is	achieved	by
left	clicking	the	atom.	Pressing	down	the	"Shift"	button	on	your	keyboard	allows	the	selection	of	multiple	atoms.

Right	clicking	on	the	black	display	will	clear	the	selection	made.

The	"Residue"	selection	mode	will	select	an	entire	residue	within	the	molecule,	by	clicking	on	a	single	atom	in	the	residue.

Making	Selections
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The	"molecule"	selection	mode	will	select	the	entire	molecule	by	clicking	on	an	atom.	Double	clicking	the	molecule	will	also
select	the	entire	molecule.
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Molecules	can	also	be	selected	by	clicking	and	dragging	your	cursor	across	the	display.
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For	more	information	refer	to	the	Selection	Tool	section.
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Select	the	"File"	menu.

Then	select	"Import",	and	"Fetch	by	chemical	name..."

A	dialog	box	will	pop	up	(depicted	below),	where	you	can	type	in	any	chemical	name.

Avogadro	will	import	the	molecule	into	the	viewing	screen	after	you	click	"OK".

Importing	Molecules	by	Name
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It	may	take	a	few	seconds	or	even	a	minute	to	download	the	molecule	online.	Avogadro	uses	the	NIH	"Chemical	Resolver"
http://cactus.nci.nih.gov/chemical/structure	to	convert	the	name	into	a	molecular	structure.
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You	can	read	PDB	files	that	you	download	yourself	from	http://www.rcsb.org/	or	access	the	PDB	code	yourself.

Older	versions	of	Avogadro	have	a	bug	with	direct	access	to	the	PDB	(since	the	website	has	moved)	but	using	v	1.2.0,	you
can	again	use	File	>	Import	>	Fetch	from	PDB...	to	download	proteins.

A	dialog	will	come	up	and	allow	you	to	enter	a	PDB	code	(e.g.,	1CRN	for	crambin)

There	it	is...	the	PDB	data	direct	from	the	website.

Importing	from	the	Protein	Data	Bank	(PDB)

Importing	directly
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If	the	direct	import	doesn't	work,	you	can	also	use	the	website	yourself.	Go	to	http://www.rcsb.org/	and	select	a	protein,	then
download	the	"PDB	File	(text)"	format	of	the	file.	From	your	downloads	folder	you	can	either	drag	and	drop	the	file	onto	an
Avogadro	display	screen,	or	drag	and	drop	the	file	over	the	Avogadro	application	icon.

Dragging	and	dropping	the	file	will	open	the	PDB	import	with	a	unit	cell	(Avogadro	displays	unit	cells	for	all	PDB	imports).

Reading	a	Downloaded	PDB	file
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If	the	unit	cell	is	unwanted,	you	can	remove	the	unit	cell	under	the	"Crystallography"	menu	by	selecting	"Remove	Unit	Cell".

Learning	Avogadro	-	The	Molecular	Editor

21Importing	from	the	Protein	Data	Bank	(PDB)



Learning	Avogadro	-	The	Molecular	Editor

22Importing	from	the	Protein	Data	Bank	(PDB)



Learning	Avogadro	-	The	Molecular	Editor

23Importing	from	the	Protein	Data	Bank	(PDB)



A	walkthrough	on	how	to	create	a	custom	peptide	model	in	Avogadro.

Select	the	“Build”	menu.

Building	a	Peptide
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Bring	up	the	peptide	builder	window.	You	can	select	amino	acids	to	insert	into	the	new	peptide.

As	you	click	on	particular	amino	acids,	they	will	be	added	to	the	sequence	on	the	right.	The	peptide	will	build	up	as	a
sequence,	starting	from	the	N	terminus.	Of	course	you	can	also	type	the	residues	directly	or	paste	from	an	online	database.
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You	can	pick	the	secondary	structure

Click	to	insert	the	sequence	into	the	main	window.	The	new	oligopeptide	will	be	selected	automatically,	and	the	manipulate
tool	will	allow	you	to	translate	and	rotate	the	chain	into	the	position	you	want.
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You	may	wish	to	re-center	the	view,	since	the	new	peptide	may	be	large.
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Avogadro	now	has	a	builder	for	nucleic	acid	sequences	and	this	walk-through	will	show	you	how	to	use	it.

The	DNA/RNA	builder	is	under	the	"Build"	menu	and	"Insert"	submenu.

Select	either	DNA	or	RNA	(1)	and	the	rest	of	the	window	will	update	accordingly.

Building	DNA/RNA
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You	can	also	control	the	number	of	bases	per	turn	as	shown	(with	defaults	for	A-DNA,	B-DNA,	Z-DNA,	or	RNA).

You	can	enter	the	sequence	either	by	clicking	the	buttons,	or	by	typing	the	one-letter	codes	directly.	For	DNA	sequences
(as	shown	here),	you	can	insert	either	single-stranded	or	double-stranded	DNA.

You	may	wish	to	re-center	the	view	or	align	the	view	to	axes	to	see	the	whole	molecule.
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There	we	go	--	the	well-known	DNA	double-helix!
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Avogadro	1.1	includes	a	new	nanotube	builder,	based	on	the	well-known	TubeGen	code	and	website	from	the	Doren	group
at	U.	Delaware.	(http://turin.nss.udel.edu/research/tubegenonline.html)

Under	the	Build	menu,	there’s	a	new	option	for	the	nanotube	builder.	At	the	moment	only	single-walled	nanotubes	(SWNT)
can	be	built	in	one	step,	although	it’s	easy	to	generate	several	nested	tubes	for	multi-walled	(MWNT)	as	shown	here.

The	builder	will	show	up	at	the	bottom	of	the	Avogadro	window.	You	can	set	the	n,m	indexes	to	determine	the	type	of
nanotube	(1)	the	length	of	the	tube	(2),	in	Angstrom,	bohr,	picometers,	nanometers,	or	periodic	unit	cells	(e.g.,	if	you	wish	to
do	a	calculation	with	periodic	boundar	conditions),	and	how	to	terminate	the	nanotube	(3).	NOTE:	determining	double
bonds	can	be	time-consuming	on	large	nanotubes.

The	nanotube	will	be	generated	aligned	along	the	z-axis,	so	you	may	want	to	re-center	the	view.

Building	Carbon	Nanotubes
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Here,	we've	added	a	6,6	nanotube	after	inserting	our	4,4	nanotube.	We'll	need	to	re-center	the	tube	to	produce	a	more
accurate	double-walled	system.

Here,	we	use	the	manual	translation	options,	new	in	Avogadro	1.1,	to	“nudge”	the	6,6	nanotube	in	the	XY	plane	to	properly
center	around	the	4,4	nanotube.

Here	we’ve	nudged	the	6,6	tube	into	an	approximately	correct	position.	We’ll	now	use	Avogadro’s	built-in	force	fields	and
the	Auto-Optimize	tool	to	relax	the	structure.
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We	(1)	select	the	Auto-Optimize	tool	to	allow	interactive	minimization	of	the	nanotubes,	and	(2)	select	the	MMFF94	force
field.	Other	forcefields	would	also	likely	work	well.	Finally	(3)	start	the	optimization.

After	a	few	steps,	you	can	see	a	nicely	relaxed	double-walled	nanotube.	You	could	repeat	the	process	as	desired.
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Avogadro	includes	over	300	common	molecules	and	molecular	fragments	to	make	building	larger	structures	easy.

Under	the	"Build"	menu,	hold	your	cursor	over	"Insert",	and	then	select	"Fragment...".

A	database	of	fragments	will	then	pop	up	(shown	below).	You	can	filter	the	selection	if	need	be.

After	you've	made	your	fragment	selection,	click	"Insert".

Insert	Fragments
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The	fragment	will	be	inserted	and	the	Manipulate	tool	will	be	selected	so	you	can	move	the	new	fragment	around	the
window.
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SMILES	(Simplified	molecular-input	line-entry	system)	allows	you	to	build	molecules	through	a	string	of	text.	If	you	have	a
SMILES	string	(e.g.,	copied	from	a	paper	or	website)	or	prefer	to	enter	one	for	a	complicated	molecule,	Avogadro	will	build
a	3D	geometry	from	the	SMILES.

Under	the	"Build"	menu,	hold	your	cursor	over	"Insert",	and	select	"SMILES...".

Enter	your	SMILES	fragment,	and	select	"OK".

There	it	is..

Building	with	SMILES
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Once	a	crystal	surface	has	been	built,	the	Super	Cell	Builder	can	expand	atoms	within	a	space	group,	replicate	the	unit	cell,
and	perform	simple	bonding.

When	"Super	Cell	Builder..."	is	selected	under	the	"Build"	menu,	the	dialog	box	below	pops	up.	This	dialog	box	will	allow
you	to	replicate	a	unit	cell	that	has	already	been	created	(if	need	be,	a	unit	cell	can	be	created	by	selecting	"Add	Unit	Cell"
under	the	"Crystallography"	menu).

One	way	supercell	can	be	utilized	is	by	creating	a	surface.	Below	is	an	elemental	unit	cell	comprised	of	silver.	This	cell	was
imported	through	the	"File"	menu,	under	"Import",	"Crystal...".	When	the	dialog	box	appears	follow	the	procedure	displayed
below.

Super	Cell	Builder

Creating	a	Surface
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A	unit	cell	can	then	be	replicated	to	make	a	slab	or	a	surface.	For	this	example,	the	parameters	were	edited	as	shown	in
the	image	below.	After	editing	the	parameters,	clicking	"Generate	Cell"	will	expand	your	surface.
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A	surface	can	then	be	modified	by	introducing	impurities.	Here,	copper	impurities	were	added	to	the	silver	surface.	This	file
can	now	be	exported	to	another	program	to	determine,	through	calculations,	how	the	impurities	will	impact	the	surface.
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Build	up	a	crystal	surface,	e.g.,	Pt	<111>	for	a	defined	Miller	Plane.

Either	open	a	CIF	file	with	the	crystal	structure	needed,	or	import	one	from	the	built-in	Avogadro	crystal	library.	The	tutorial
will	assume	you	import	a	structure	from	the	Avogadro	library.	Choose	File	>	Import	>	Crystal	to	bring	up	the	library.

Either	browse	through	the	crystals,	or	type	a	filter	--	by	element	or	name.	Click	"Insert"	to	import	the	selected	structure.

Building	a	Crystal	Surface	(Slab)

Import	the	appropriate	crystal	structure.
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Importing	a	crystal	will	show	the	asymmetric	unit	cell	(e.g.,	one	atom	for	Silver	here).

To	build	a	specified	surface	(e.g.,	Ag	<121>)	choose	Crystallography	>	Build	>	Slab...	to	bring	up	the	slab	builder	settings.
Future	crystal	builders	(e.g.,	nanoparticles,	supercells)	will	also	appear	in	this	menu.

Specify	the	indices	of	the	Miller	plane	desired	(for	hexagonal	unit	cells,	all	4	indices	will	appear),	and	choose	the
dimensions	in	either	distances	or	repeating	cells	of	the	resulting	surface.	The	generated	surface	is	aligned	in	the	XY	plane,
and	a	specified	thickness	will	be	cleaved	in	the	z-axis	below	the	XY	plane.	This	feature	allows	easy	alignment	between	a
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new	surface	and	a	molecule	for	surface	interaction	calculations.	Click	"Build"	to	start	the	surface	generation.

After	clicking	"Build,"	Avogadro	will	generate	a	large	supercell,	align,	rotate,	and	cleave	the	designated	surface.	This	may
take	some	time,	depending	on	the	size	of	the	crystal	cell.	Here	translucent	van	der	Waals	spheres	are	used	to	illustrate	the
corrugation	of	the	Ag	<121>	surface.	The	resulting	surface	is	a	2x2	supercell,	with	a	large	spacing	(40	Å)	in	the	z-axis.
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A	walk-through	on	creating	a	unit	cell	(of	a	polymer)	using	Avogadro	and	the	Align	tool.	This	specific	example	uses
Gaussian,	but	translation	vectors	for	other	programs	can	be	performed	similarly.

Build	out	the	molecule	for	the	unit	cell.	Notice	that	while	the	repeat	unit	here	is	2	rings,	we	have	built	3	rings.	This	way,	we
will	properly	model	the	bond	which	spans	two	unit	cells.

Optimize	the	geometry	of	the	molecule.

Building	a	Polymer	Unit	Cell
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Switch	to	the	Align	tool	to	translate	and	orient	the	unit	cell	coordinates.

Make	sure	to	open	the	Tool	Settings	window,	which	will	allow	you	to	work	with	the	Align	tool.

First	click	on	the	"start"	atom	of	the	polythiophene.	This	atom	will	be	translated	to	the	origin	(0,	0,	0).	Then	click	on	the
corresponding	atom	in	the	"next"	unit	cell.	The	distance	between	these	two	atoms	will	define	one	axis	in	the	unit	cell.

In	the	"Align	Settings"	window,	define	an	axis	for	the	unit	cell.	Then	click	the	Align	button.	This	will	change	the	coordinate
set	to	have	atom	#1	at	the	origin,	and	atom	#2	(from	the	step	above)	projected	onto	the	x-axis.
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Open	the	Cartesian	Editor	window	to	verify	the	results	of	the	Align	operation.

Notice	that	atom	#1	is	at	the	origin,	and	atom	#11	is	projected	onto	the	X-axis.	The	size	of	the	unit	cell	is	7.806Å	--	the
distance	between	atom	#1	and	atom	#11.

Now	delete	"extra"	atoms	which	should	not	be	included	in	the	unit	cell	calculations.	This	includes	the	third	ring	(including
atom	11)	and	the	"end"	hydrogen	atoms.	For	example,	you	can	use	the	select	tool	and	drag	over	the	atoms	to	be	deleted	to
pick	them.
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Once	selected,	you	can	use	the	"Clear"	menu	command	to	delete	the	atoms.

If	you	wish	to	submit	the	unit	cell	to	Gaussian,	pick	the	Gaussian	input	extension.

Set	options	as	you	desire.	Make	sure	to	add	a	"TV	7.806	0.0	0.0"	line	at	the	bottom	of	the	preview	text.	This	will	enable	the
unit	cell	calculation	by	setting	the	translation	vector	for	the	unit	cell.
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Calculation	results	often	specify	all	atoms	and	translation	vectors,	but	not	the	space	group.	Here	we	see	how	to	perceive
the	space	group	from	a	set	of	crystallographic	coordinates.

Here	we	open	an	example	VASP	calculation	by	opening	the	POSCAR	file.

Crystal	Symmetry	Perception

Open	a	Crystal	File
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This	example	is	triclinic,	looking	for	Li	/	H	structures.	Note	that	VASP	files	do	not	specify	a	space	group,	so	it	is	reported	as
"Unknown."

We	can	either	set	the	spacegroup	manually,	or	here,	perceive	the	space	group,	using	the	open	source	spglib	code.

We	need	to	set	the	tolerance,	since	some	atoms	may	be	slightly	out	of	place	in	Cartesian	coordinates.

Our	example	VASP	file	isn't	very	interesting	--	the	space	group	is	P1.

Here's	another	example,	where	the	space	group	is	P	1	21	1.
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Some	simulations	use	"supercells"	--	larger	periodic	boundary	systems	than	the	primitive	unit	cell.	Here	is	a	walk-through
on	reducing	a	large	supercell	to	the	primitive	unit	cell.

Open	or	import	the	file	with	the	supercell	--	here,	CaCO3.	Note	that	the	space	group	is	unknown,	since	the	file	came	from
VASP,	which	does	not	specify	a	space	group	with	the	coordinates.

After	perceiving	the	space	group,	we	see	correctly	that	the	system	is	R	-3	c.	Now	we	can	reduce	the	supercell	to	a	primitive
cell	of	CaCO3.

Reducing	Crystals	to	Primitive	Unit	Cells
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Avogadro	provides	two	algorithms	for	reducing	the	unit	cell	to	a	primitive	or	Niggli	cell.	Here,	pick	"Primitive."	Note	that	the
volume	of	this	supercell	was	over	4,000	Å3.

You	will	need	to	set	a	tolerance	for	the	Cartesian	coordinates	(here,	in	Å).

After	reduction,	note	that	the	space	group	is	retained,	the	lattice	is	properly	Rhombohedral,	and	the	unit	cell	volume	is	36
times	smaller.
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Avogadro	1.1	allows	you	to	adjust	the	volume	or	spacing	of	a	unit	cell.

After	creating	or	opening	the	crystal	(here	ice),	we	see	the	normal	unit	cell	and	lattice	information.	We	will	now	adjust	the
cell	volume.

Before	we	scale	volume,	we	can	either	choose	to	preseve	Cartesian	coordinates	(which	will	add	empty	space	to	the	edges
of	the	unit	cell)	or	preserve	fractional	coordinates	(which	will	symmetrically	scale	the	entire	unit	cell).	This	walk-through	will
show	both.

Scaling	Crystal	Volumes
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First	we'll	scale	the	cell	while	preserving	Cartesian	coordinates.

The	units	of	the	volume	are	determined	by	your	settings	(here	Å).	We	adjust	the	volume	from	the	original	389.78Å3,	and
click	"OK."

Here,	we've	greatly	exaggerated	the	volume,	to	show	the	empty	space	(arrows)	around	the	outside	of	the	unit	cell
boundaries,	when	preserving	Cartesian	coordinates.	The	space	group	has	also	changed	(to	C	1	m	1).
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If	you	preserve	fractional	coordinates,	you	can	scale	the	unit	cell	symmetrically.

Note	that	while	the	volume	is	significantly	expanded,	the	space	group	(and	fractional	coordinates)	are	retained.
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Beyond	building	a	crystal	surface,	new	features	in	Avogadro	make	it	easy	to	consider	molecule-surface	interactions.	The
lesson	picks	up	at	the	end	of	the	"Building	a	Crystal	Surface"	lesson.

Generate	the	desired	crystal	surface.	Avogadro	will	center	the	surface	cell,	aligned	in	the	XY	plane,	with	slab	atoms	defined
below	Z	=	0.	The	Slab	Builder	also	leaves	a	large	space	along	the	z-axis	to	allow	insertion	of	molecules	for	surface
interaction	calculations.	You	can	control	this	padding	as	indicated	above.

In	a	new	window,	draw	the	desired	molecule,	or	open	a	file.	Here	we	consider	ethanol.

Molecule-Surface	Interactions

Start	with	a	generated	Crystal	Surface

New	Window:	Create	our	Molecule
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We	will	use	the	"Align	Tool"	to	allow	us	to	rotate	and	align	the	molecule	with	the	OH	group	at	the	origin,	and	the	molecule
aligned	along	the	z-axis.

We	will	click	on	the	terminal	H	atom	(which	will	be	translated	to	the	origin)	followed	by	the	carbon	atom	(which	will	define
the	z-axis	of	the	molecule).

After	defining	the	atoms	(they	will	show	colored	spheres	and	numbers	once	selected),	click	on	the	"Align"	button	to
translate	and	rotate	the	molecule.

You	may	wish	to	alter	the	current	camera	view.	Choosing	View	>	Align	View	to	Axes	will	reset	the	view	to	project	the	z-axis
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of	the	molecule	to	point	towards	you.

Perfect!	Now	we	can	copy	our	ethanol	to	the	surface	document.

After	copying,	we	can	switch	to	our	surface.

Now	we'll	paste	in	the	ethanol	molecule.
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Note	that	the	ethanol	is	now	embedded	in	the	surface,	centered	as	desired.	The	Manipulate	tool	has	been	selected,	allow
us	to	translate	the	molecule	as	needed.

New	in	version	1.1	is	an	option	to	specify	the	exact	amount	to	translate	or	rotate	the	selection	(i.e.,	the	molecule	we	just
pasted).	Here,	we've	specified	that	we	want	to	move	the	molecule	+2.5Å	along	the	z-axis,	above	the	surface,	and	then	we
click	"Apply"	to	complete.	We	could	also	rotate	around	the	z-axis	if	the	positioning	isn't	as	desired.
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Here	we	have	translated	the	ethanol	2.5	Å	above	the	Ag	<121>	surface	and	are	ready	to	submit	for	a	calculation.
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Molecules	can	be	built	and	edited	with	the	draw	tool.

You	can	begin	creating	a	molecule	by	left	clicking	on	the	black	display.	This	will	generate	a	carbon	atom.	Right	clicking	on
the	atom	will	delete	it.

Left	clicking	and	dragging	the	mouse	will	generate	a	bond	to	another	carbon	atom.

The	Draw	Tool

1.	Creating	a	Molecule

2.

3.
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Different	elements	can	be	selected	from	the	Element	drop	down	menu.	Typing	the	atomic	symbol	(e.g.,	"A-s"	for	Arsenic)	is
a	shortcut	for	changing	the	selected	element.

For	example,	if	you	wanted	to	create	water,	you	can	type	in	"O",	or	select	"Oxygen	(8)"	from	the	drop	down	menu	and	click
on	the	black	display.

4.

5.
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If	the	"Adjust	Hydrogens"	box	is	checked,	hydrogens	in	the	molecule	are	automatically	adjusted	to	satisfy	valency	(as
shown	above).

Bond	order	can	be	changed	through	the	Bond	Order	drop	down	menu,	or	by	typing	the	numbers	"1",	"2",	or	"3".	Bonds	can
also	be	added	to	a	molecule	by	left	clicking	on	a	bond	that	has	already	been	created	(this	process	cycles	through	single,
double,	and	triple	bonds).	Right	clicking	on	a	bond	will	delete	the	bond,	and	the	atom	it's	bonded	to.

6.

7.
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For	example,	to	create	carbon	dioxide,	the	general	structure	("O-C-O")	needs	to	be	drawn,	and	then	by	left	clicking	the
bonds	in	the	molecule,	double	bonds	will	be	created.

8.
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Under	the	"Extensions"	menu,	the	geometry	of	a	molecule	can	be	optimized	by	selecting	"Optimize	Geometry".

9.
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The	navigation	tool	is	used	to	pan,	rotate,	and	scale	the	view	of	a	molecule.

If	the	"Display	visual	cues"	box	is	checked,	yellow	arrows	will	display	what	type	of	navigation	is	taking	place.

Clicking	anywhere	on	the	black	display	and	dragging	the	mouse	will	tilt,	and	rotate	the	entire	molecule	(as	shown	below).

The	Navigate	Tool
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A	molecule	can	also	be	rotated	about	an	atom	by	clicking	the	atom	and	dragging	the	mouse.	Depicted	below,	acetone	is
being	rotated	about	it's	initial	carbon.

Right	clicking	allows	you	to	change	the	molecules	location	on	the	display.	Double	clicking	the	molecule	will	reset	the
molecule's	view.

Using	the	middle	scroll	bar	on	a	mouse	will	allow	you	to	zoom	in	and	out.
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The	Bond-Centric	Manipulate	tool	alters	angles,	bonds,	and	torsions	of	a	molecule.

Left	clicking	on	a	bond	and	dragging	your	cursor	allows	you	to	adjust	the	plane.	If	the	"Show	Angles"	box	is	checked,	the
angles	from	the	selected	bond	to	all	adjacent	bonds	are	displayed.

As	you're	rotating	the	plane	you'll	notice	that	if	the	"Snap-to	Bonds"	box	is	checked,	the	plane	will	change	colors	between
yellow	and	blue.	If	the	plane	depicted	is	yellow	then	the	plane	is	in	line	with	an	adjacent	bond.	If	the	plane	depicted	is	blue
the	plane	is	not	in	line	with	any	adjacent	bonds.

The	"Snap-to	Threshold"	determines	how	far	away	a	plane	has	to	be	to	snap	to	an	adjacent	bond	plane.	For	example,
below	the	Snap-to	Threshold	is	10	degrees.	If	the	plane	being	rotated	comes	within	10	degrees	of	an	adjacent	bond,	that
plane	will	snap	to	the	adjacent	bond	plane.	If	the	Snap-to	Threshold	is	changed	to	90	degrees,	the	rotating	plane	will	only
snap	to	adjacent	bond	planes.

The	Bond-Centric	Manipulate	Tool
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Once	a	plane	is	selected	the	atoms	on	either	end	of	the	plane	can	be	manipulated,	by	left	clicking	on	the	atom	and
dragging.	The	displayed	angles	will	automatically	adjust,	and	the	selected	bond	will	not	change	in	length.

Left	clicking	on	a	substituent,	or	in	this	case	a	hydrogen	bonded	to	one	of	the	selected	carbon	atoms	will	allow	you	to	adjust
the	torsion	angle.
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The	manipulate	tool	allows	you	to	move	atoms	and	selected	fragments.

If	inserting	a	fragment,	the	manipulate	tool	is	automatically	selected	so	that	the	fragment	can	easily	be	rotated	into	position.

The	"Translate	by:"	section	allows	you	to	easily	translate	the	length	of	a	bond	(to	a	fragment	or	atom)	into	the	desired
positon.	For	a	translation	to	take	place,	enter	in	the	desired	translation	and	then	click	"Apply".

The	"Rotate	around:"	section	allows	you	to	rotate	your	selection	around	the	geometry,	or	the	origin.	This	section	then	gives
you	the	ability	to	choose	how	many	degrees	to	rotate	the	fragment.	Click	"Apply"	once	you've	made	your	selection.

The	Manipulate	Tool
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Clicking	"Reset"	will	reset	all	of	the	information	in	the	translation,	and	rotation	boxes.	This	does	not	reset	the	molecule,	if
you	want	to	undo	your	adjustments	go	to	the	"Edit"	menu	in	the	top	bar	and	select	"Undo	Manipulate	Atom".
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The	selection	tool	allows	the	indiviual	selection	of	atoms,	bonds,	or	fragments.

There	are	three	types	of	selection	modes:	"Atom/Bond",	"Residue",	and	"Molecule".

The	"Atom/Bond"	selection	mode	provides	you	with	the	ability	to	select	a	single	atom	within	a	molecule.	This	is	achieved	by
left	clicking	the	atom.	Pressing	down	the	"Shift"	button	on	your	keyboard	allows	the	selection	of	multiple	atoms.

Right	clicking	on	the	black	display	will	clear	the	selection	made.

The	"Residue"	selection	mode	will	select	an	entire	residue	within	the	molecule,	by	clicking	on	a	single	atom	in	the	residue.

The	Selection	Tool
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The	"molecule"	selection	mode	will	select	the	entire	molecule	by	clicking	on	an	atom.	Double	clicking	the	molecule	will	also
select	the	entire	molecule.
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Molecules	can	also	be	selected	by	clicking	and	dragging	your	cursor	across	the	display.
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Clicking	on	"Add	Center	of	Atoms"	will	display	a	black	ball	where	the	center	of	the	atoms	is	found.

Clicking	on	the	"Add	Center	of	Mass"	will	display	a	black	ball	where	the	center	of	mass	of	the	molecule	is	found.
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The	auto	rotate	tool	allows	for	the	continuous	rotation	of	a	molecule.

To	rotate	the	molecule,	adjust	the	x,	y,	and	z	rotation	scales	as	desired.	Then	select	"Start".

You	can	also	click	and	drag	from	an	atom	to	rotate	the	molecule	in	a	specific	direction.

The	Auto-Rotate	Tool
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Select	"Stop"	to	end	the	molecule's	rotation.

Clicking	"Reset"	will	zero	out	the	rotation	scales	and	stop	the	rotation.
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The	Auto	Optimize	tool	continuously	optimizes	molecular	geometry	through	molecular	mechanics.	This	tool	also	gives	you
the	ability	to	manipulate	the	molecule	while	the	molecular	geometry	is	being	minimized.

The	Auto-Optimization	settings	provide	several	force	field	options.	The	default	force	field	is	UFF	or	the	Universal	Force
Field.	This	force	field	is	capable	of	reproducing	the	most	structural	features	across	the	periodic	table.	However,	depending
on	the	molecule	being	tested,	the	other	force	fields	may	be	better	suited	to	optimize	the	molecular	parameters.	The	force
field	options	are	shown	below.	For	more	information	on	force	fields	refer	to	the	optimizing	geometry	section	of	this	lab
manual.

The	default	setting	for	"Steps	per	Update"	is	4.	This	number	can	be	increased	or	decreased,	if	you	have	a	slower	computer
consider	decreasing	this	number.

The	Auto-Optimize	Tool
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Avogadro	can	also	apply	specific	algorithms	dependent	on	your	need.	Steepest	descent	is	the	most	fluid	and	interactive
system,	and	is	the	default	algorithm.

If	necessary,	atoms	can	be	fixed	into	place	before	optimization	so	that	they	don't	move.	This	is	done	by	going	to	the
"Extensions"	menu,	holding	your	cursor	over	"Molecular	Mechanics"	and	selecting	"Fix	Selected	Atoms".
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Clicking	on	"Start"	will	allow	you	to	manipulate	the	molecule	by	left	clicking	on	an	atom	and	dragging	your	cursor.	Notice
that	the	fixed	atoms	don't	bend	with	the	manipulation	of	the	molecule.

If	the	"Fixed	atoms	are	movable"	box	is	checked,	the	bonds	between	atoms	can	be	manipulated	but	are	constrained.	In	this
instance	the	selected	atom	does	not	reoptimize	once	it's	dragged.
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Essentially,	the	same	thing	takes	place	if	the	"Ignored	atoms	are	movable"	box	is	checked.	However,	ignored	atoms	(if	the
box	is	checked)	will	reoptimize	once	dragged.	To	ignore	a	selection	select	the	"Extensions"	drop	down	menu,	hold	your
cursor	over	"Molecular	Mechanics"	option,	and	select	"Ignore	Selection".

The	molecule	will	reoptimize	until	dE=0	or	"Stop"	is	clicked.
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The	measure	tool	determines	bond	lengths,	angles,	and	dihedrals.

The	measure	tool	allows	you	to	select	and	assess	up	to	four	atoms.

As	you	click	on	atoms	Avogadro	will	automatically	calculate	the	distances	between	atoms	in	a	respective	order.	For
example,	the	distance	between	atom	1	and	2	is	1.376	Å.

The	Measure	Tool
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When	three	atoms	are	selected	an	angle	is	measured	between	the	first	and	third	atom,	and	the	second	atom	is	the	vertex.

If	four	atoms	are	selected,	a	dihedral	angle	is	determined.

Learning	Avogadro	-	The	Molecular	Editor

90Measure	Tool



Right	clicking	the	display	will	reset	the	atoms	previously	selected.
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The	align	tool	rotates,	and	translates	a	molecule(s)	into	a	specific	reference	frame.

An	alignment	axis	can	be	chosen	from	the	"Axis"	drop	down	menu.	Typing	"x",	"y",	or	"z"	is	a	shortcut	for	changing	the
alignment	axis.

You	can	also	choose	to	align	everything	in	the	frame,	or	a	specific	molecule	with	the	respective	option	in	the	"Align"	drop
down	menu.	To	align	a	molecule,	or	everthing	in	the	frame	you	will	then	need	to	click	two	atoms	as	reference	points.

The	Align	Tool
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Clicking	"Align"	will	then	reset	the	frame	with	the	new	alignment.	The	alignment	axes	are	shown	in	the	bottom	left	corner.
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Avogadro	comes	equipped	with	various	display	types	to	aid	in	molecular	interpretation.	The	default	engine	plugins	include
Axes,	Ball	and	Stick,	Cartoon,	Dipole,	Force,	Hydrogen	Bond,	Label,	Polygon,	QTAIM,	Ribbon,	Ring,	Simple	Wireframe,
Stick,	Surface,	Van	der	Waals	Spheres,	and	Wireframe.

The	different	display	types	can	be	accessed	by	clicking	"Display	Settings..."	in	the	top	middle	of	the	open	Avogadro	window.
The	display	types	toolbar	will	be	added	above	the	"Tool	Settings..."	toolbar	that	is	currently	opened.	All	of	the	plugins
featured	below	can	be	used	in	conjunction	with	one	another.

Clicking	on	the	wrench	located	on	the	right	of	some	display	types	will	allow	various	adjustments	to	be	made	to	the	display.
For	example,	you	can	choose	to	edit	the	opacity	of	the	Van	der	Waals	Spheres	feature	so	that	you	can	still	view	the	ball
and	stick	model	underneath.

Different	Display	Types	in	Avogadro

Locating	Display	Types
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Clicking	on	the	Axes	plugin	will	provide	the	cartesian	axes	of	the	molecule	from	the	origin.	Note	that	the	red,	green,	and
blue	arrows	represent	the	x,	y,	and	z	axes	respectively.

Axes
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Ball	and	Stick	is	the	default	plugin	when	Avogadro	is	opened.	This	plugin	provides	the	standard	ball	and	stick
representation	of	a	molecule.

Ball	and	Stick
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The	cartoon	feature	only	applies	to	secondary	biological	structures	(α	helix	and	β	sheet).	Below	is	the	cartoon	for
hemoglobin.

Cartoon
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The	Dipole	plugin	will	display	an	overall	net	dipole	if	one	is	present.

Dipole
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The	Force	plugin	displays	green	arrows	on	atoms	(as	shown	below),	to	qualitatively	demonstrate	the	forces	being	applied
to	the	atoms.

Force
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The	Hydrogen	Bond	plugin	demonstrates	implicit	hydrogen	bonding	that	can	occur	between	atoms.

Hydrogen	Bond

Learning	Avogadro	-	The	Molecular	Editor

100Different	Display	Styles



The	label	plugin	numbers	and	labels	all	atoms	present	in	a	molecule.

The	Polygon	feature	takes	metallic	centers	with	three	or	more	atoms	bonded	to	them,	and	draws	a	polygon	around	them.

Label

Polygon
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QTAIM	displays	the	implicit	bonding	that	is	theorized	to	take	place	between	the	hydrogens	of	organic	crystals	(the	implicit
bonding	is	conveyed	through	dots).	This	display	type	is	utilized	by	importing	a	.wfn	file	from	the	"QTAIM",	"Molecular	Graph"
selection	under	the	"Extensions"	menu.	More	information	can	be	found	on	this	process	in	the	Tutorial	section	of	this
manual.

QTAIM	(Quantum	Theory	of	Atoms	in	Molecules)
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Similar	to	the	Cartoon	plugin,	the	Ribbon	plugin	conveys	secondary	biological	structures	as	a	simple	ribbon	rendering.

Ribbon
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This	feature	distinguishes	rings	with	different	colors	dependent	on	their	size.	As	shown	below	a	six-membered	ring	is
purple,	and	five	membered	ring	is	blue,	etc.

Ring
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This	feature	provides	a	basic	wireframe	display	of	a	molecule.

Simple	Wireframe
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Stick	is	another	molecular	visual	display	type,	that	renders	a	stick	representation	of	a	molecule.

Once	a	surface	has	been	created	(Extensions	Menu	->	Create	Surfaces...),	the	Surface	display	type	can	be	used.	This
display	type	allows	adjustments	to	the	orbital,	opacity,	rendering,	style,	and	color.

Stick

Surfaces
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The	Van	der	Waals	plugin	provides	the	classic	sphere	rendered	Van	der	Waals	image.

Van	der	Waals	Spheres
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Unlike	Simple	Wireframe,	Wireframe	draws	atoms	and	bond	order	into	the	molecule.

Wireframe
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Coloring	various	parts	of	a	molecule	can	provide	a	more	visually	stimulating	way	to	display	qualitative	information.

Below	hemoglobin	is	depicted	in	its	ball	and	stick	form	(file	imported	from	PDB).

We	can	select	specific	residues	in	the	molecule	through	the	"Select"	menu.

Coloring	Part	of	a	Molecule

Hemoglobin

Select	by	Residue
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After	typing	in	the	residue	name	(this	feature	is	case	sensitive),	and	clicking	"OK",	adjustments	can	be	made	to	emphasize
the	selection.
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After	making	a	selection,	click	the	wrench	next	to	the	display	type	you're	choosing	to	edit	(in	this	instance	the	Ball	and	Stick
display).	When	the	dialog	box	pops	up	select	"Objects",	and	then	click	the	blue	table	button	in	the	bottom	right	hand	corner.
This	feature	adjusts	what	was	initally	considered	an	object	(Hemoglobin),	and	edits	the	selection	so	that	the	display	type
will	only	encompass	the	heme	residues.
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From	there	you	can	edit	other	settings	of	the	display	type	by	clicking	on	"Settings"	or	"Colors".
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Coloring	parts	of	a	molecule	doesn't	have	to	end	after	a	single	adjustment.	Say	we	want	to	stress	that	iron	is	at	the	center
of	the	heme	residue.	We	can	go	to	the	"Select"	menu,	"Select	by	Element...",	and	choose	to	select	all	of	the	iron	atoms	in
the	molecule.

Select	by	Element
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After	the	selection	has	been	made,	with	the	same	procedure	as	before,	we	can	choose	a	display	type	and	edit	the	selection
so	that	it	only	encompasses	the	iron	atoms.
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Then	adjustments	can	be	made	to	the	settings.
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The	final	product	is	an	intuitive	view	of	qualitative	information	about	the	molecule.
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The	file	menu	provides	the	standard	abilities	of	creating	a	new	file,	opening	&	closing	documents,	as	well	as	saving
documents.	It	also	yields	the	capability	to	import	files	from	various	databases.

The	"New"	selection	will	open	a	new	file	in	Avogadro.

After	selecting	"Open",	a	file	that	has	previously	been	saved	is	accessible	through	the	pop	up	browser.

"Open	Recent"	displays	a	list	of	documents	recently	launched.

"Close"	dismisses	the	window	currently	open.

"Save"	will	maintain	your	progress.

"Save	As..."	allows	you	to	save	progress	without	overwriting	the	original	file.

"Revert	to	Saved"	will	revert	any	changes	made	to	the	previously	saved	file.

The	File	Menu

New

Open

Open	Recent

Close

Save

Save	As...

Revert	to	Saved
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"Import"	will	open	chemical	files	that	have	already	been	created,	from	a	database.

"Export"	will	make	files	created	in	Avogadro	suitable	for	other	programs.

Import

Export
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The	edit	menu	administers	basic	file	revisions.

"Undo"	will	negate	the	last	change	to	the	document.

"Redo"	will	recover	the	last	change	to	the	document.

"Cut"	will	remove	and	copy	the	whole	molecule	or	a	selection.

"Copy"	will	create	a	duplicate	of	the	entire	molecule	or	a	selection,	and	place	it	on	a	clipboard.

"Copy	As"	provides	text	representations	of	the	molecules	present	in	the	viewing	screen.	For	example,	selecting	"Copy	As"
and	"SMILES",	renders	"C(=O)(C)C.O.O"	as	the	output	for	the	viewing	screen	below.	This	selection	can	then	be	pasted	in	a
text	document	for	external	projects.

The	Edit	Menu

Undo

Redo

Cut

Copy

Copy	As
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"Paste"	recalls	the	last	data	copied	onto	the	clipboard.

"Clear"	removes	all	chemical	structures	from	the	viewing	window.

"Select	All"	highlights	everything	in	the	screen	(this	feature	can	also	be	found	under	the	"Select"	menu).

Paste

Clear

Select	All
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"Select	None"	will	dismiss	everything	in	the	display	(this	feature	is	also	found	under	the	"Select"	menu).

Select	None
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The	view	menu	gives	the	user	the	ability	to	add,	and	adjust	the	display	views	currently	in	use.

"New	View"	creates	a	new,	blank	viewing	window.

By	selecting	"Duplicate	View"	from	the	drop	down	bar,	a	duplicate	of	the	current	view	will	be	created.	Any	changes	made	to
the	display	window	will	automatically	update	in	all	of	the	views.

The	View	Menu

New	View

Duplicate	View
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The	"Detach	View"	selection	will	display	the	current	view	in	a	new	window.

Detach	View
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"Close	View"	deletes	the	display	that's	open.	A	view	can	also	be	closed	by	clicking	the	x	on	the	left	of	the	view	tab.

Close	View
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"Center"	will	align	the	molecule(s)	to	the	middle	of	the	viewing	screen.

"Align	View	to	Axes"	adjusts	the	display	view	to	be	in	the	x,	y	plane	with	the	positive	z-axis	pointing	toward	you.

"Full	Screen"	expands	the	window	to	fill	the	computer	screen.

Center

Align	View	to	Axes

Full	Screen

Reset	Display	Types
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"Reset	Display	Types"	will	deselect	all	display	types	checked,	and	revert	back	to	the	default	"Ball	and	Stick"	display	type.

The	"Set	Background	Color..."	feature	will	allow	you	to	change	the	background	color	of	the	viewing	window.

Set	Background	Color...
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There	are	two	types	of	projection	features	(prospective,	and	orthographic	projection),	the	default	projection	is	perspective
projection.	Perspective	projection	provides	a	more	realistic	(3D)	view	of	a	molecule	in	space.	Orthographic	projection
provides,	and	adjusts	the	molecule	into	a	planar	(2D)	view,	where	all	like	atoms	are	adjusted	to	stay	the	same	size.	The
projection	views	are	most	evident	when	drawing	molecules.

"Display	Axes"	will	render	an	axes	display	in	the	lower	left	hand	corner.

Projection

Display	Axes
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"Debug	Information"	provides	additional	information	about	the	view,	and	what's	currently	taking	place	on	your	screen.

Debug	Information
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Adjusts	the	3D	molecular	image	in	the	viewing	screen	to	achieve	a	faster	image	rendering	on	slow	computers.	On	most
modern	(2012	or	later)	computers,	this	is	not	necessary.

"All	Molecules	in	File..."	allows	you	to	look	at	all	of	the	molecules	that	have	previously	been	created	and	embedded	into	one
file.	From	the	dialog	box	that	pops	up,	you	can	select	and	edit	a	molecule	by	clicking	on	the	molecule's	title.

Use	Quick	Render

All	Molecules	in	File...
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"Crystal	View	Options..."	when	selected	will	open	the	toolbar	shown	below.	This	toolbar	allows	you	to	edit	the	Miller	indices,
and	the	Unit	Cell	for	any	crystal	structure.

Crystal	View	Options...
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The	"Properties"	selection	will	provides	you	with	molecule,	atom,	bond,	angle,	torsion,	and	conformer	properties.	These
settings	display	general	compository	information	about	the	molecule	and	atoms	present.

For	example,	clicking	on	"Molecule	Properties"	will	display	general	molecular	information.

Properties
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The	build	menu	helps	to	ease	the	process	of	constructing	molecules.

"Cartesian	Editor..."	when	selected	provides	you	with	the	capability	to	manually	adjust	bond	lengths.	The	dialog	box	for	the
cartesian	editor	is	displayed	below.

The	sort	by	drop	down	menu	will	rearrange	the	data	in	the	dialog	box	for	your	convenience.	Sort	by	can	arrange	the	data	by
element,	or	by	location	of	the	atom.	All	of	the	data	for	sorting	by	X,	Y,	and	Z	coordinates	will	start	reading	at	the	atom	to	the
furthest	left	in	the	molecule,	and	continue	until	it	reaches	the	atom	at	the	right	most	point.

The	Build	Menu

Cartesian	Editor...

1.	Sort	by...

Learning	Avogadro	-	The	Molecular	Editor

133Build	Menu



Avogadro	provides	three	units	of	measure	to	adjust	bond	lengths,	Angstroms,	Bohrs,	and	Fractional	coordinates.	A	unit	cell
must	be	defined	to	use	fractional	coordinates.

2.	Unit	of	Measure
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Editing	the	data	is	as	simple	as	clicking	on	the	number	you	wish	to	edit,	and	typing	in	a	new	coordinate.	After	clicking
"Apply"	and	returning	back	to	the	Avogadro	display	screen,	you	should	notice	that	the	atom	has	changed	position.

The	displayed	data	can	also	be	modified	according	to	your	personal	preference,	or	for	the	use	of	additional	plugins.

"Change	H	to	Methyl"	will	replace	any	Hydrogens	present	in	the	display	window	with	methyl	groups.	Depicted	below	is
acetone	with	all	of	its	hydrogens	replaced	by	methyl	groups.

3.	Editing	&	Modifying	Data

Change	H	to	Methyl
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"Add	Hydrogens"	will	satisfy	the	valency	of	the	atoms	present	with	hydrogens.

Add	Hydrogens
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"Add	Hydrogens	for	pH..."	will	create	a	dialog	box	(displayed	below)	that	allows	you	to	adjust	the	pH	of	the	molelcular
environment.	This	feature	will	add	(or	subtract)	acidic	hydrogens	to	ionizable	groups	in	peptides,	according	to	the	desired
pH.

"Remove	Hyrogens"	will	delete	all	hydrogens	in	the	display	screen.

Add	Hydrogens	for	pH...

Remove	Hydrogens

Learning	Avogadro	-	The	Molecular	Editor

137Build	Menu



"Insert"	provides	a	faster,	simpler	way	of	building	molecules.	A	depicted	below,	you	can	insert	DNA/RNA,	a	Fragment,	a
Peptide,	and	can	also	insert	a	molecule	based	on	SMILES	text.

"Invert	Chirality"	will	reverse	(invert)	the	initial	configuration	to	the	opposite	R/S	configuration.

Insert

Invert	Chirality
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Information	on	the	Super	Cell	Builder	can	be	found	in	"Building	and	Editing	Crystals	and	Materials"	section.

Information	on	building	Carbon	Nanotubes	in	Avogadro	can	be	found	in	the	"Building	Molecules"	section.

Super	Cell	Builder...

Nanotube	Builder...
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The	select	menu	makes	chemical	alterations	more	efficient	through	various	modes	of	selection.

"Select	All"	highlights	everything	in	the	display	(this	feature	can	also	be	found	under	the	"Edit"	menu).

"Select	None"	will	dismiss	everything	in	the	display	(this	feature	is	also	found	under	the	"Edit"	menu).

"Invert	Selection"	reverses	the	selection	made.

The	first	image	displayed	below	is	the	orginal	selection,	and	the	second	image	demonstrates	the	inverted	selection.

The	Select	Menu

Select	All

Select	None

Invert	Selection
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SMARTS	(**SMiles	ARbitrary	Target	Specification)**	is	a	more	general	chemical	language	extension	of	SMILES.	"Select
SMARTS..."	allows	you	to	use	this	chemical	language	to	select	various	atoms,	or	groups	of	atoms	within	the	molecule.	For
example,	typing	"a"	into	the	dialog	box	and	clicking	ok	will	select	all	atoms	with	aromaticity.	More	information	can	be	found
at	the	Daylight	SMARTS	webpage.

"Select	by	Element..."	generates	a	periodic	table	pop	up	screen	that	allows	you	to	select	an	element	throughout	the	viewing
display.

Select	SMARTS...

Select	by	Element...
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"Select	by	Residue..."	generates	a	pop	up	screen	that	allows	you	to	select	residues	with	specified	names.	For	example,
typing	in	"ALA"	(this	feature	is	case	sensitive)	to	select	an	alanine	residue.

This	feauture	only	works	with	residues	that	were	made	using	the	peptide	builder.

Select	by	Residue...
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This	feature	will	select	"HOH"	residues	in	PDB	(protein	data	bank)	files.

"Add	Name	Selection..."	allows	you	to	add	a	new	selection	to	the	current	data	base,	which	you	can	then	recall	at	your
convenience.

Select	Solvent

Add	Name	Selection...
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The	Extensions	Menu	is	a	list	of	plugins	to	Avogadro,	including	molecular	mechanics	geometry	optimizations	and	interfaces
to	other	computational	chemistry	packages.

Selecting	"Animation"	will	open	the	animate	trajectory	dialog	box	shown	below.	From	here	you	can	load	a	file,	view	and	edit
the	animation,	as	well	as	save	the	file	in	a	PC	compatible	format.

"Optimize	Geometry"	provides	a	quick,	realistic	rendition	of	a	molecule	using	molecular	mechanics.

The	Extensions	Menu

Animation

Optimize	Geometry
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"Molecular	Mechanics"	allows	you	to	edit	the	geometry	optimization	of	a	molecule,	so	that	it	best	suits	your	purposes.

A	dialog	box	will	open	when	"Setup	Force	Field..."	is	selected.	This	dialog	box	provides	you	with	the	ability	to	choose	the
type	of	force	field	that	would	best	optimize	your	molecular	parameters.

Molecular	Mechanics

Setup	Force	Field...
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"Calculate	Energy"	determines	the	amount	of	energy	per	the	amount	of	material	(kJ/mol),	and	displays	this	number	in	a	pop
up	dialog	box.

"Conformer	Search"	is	a	way	to	easily	search	for	conformers	within	a	molecule	(dialog	box	shown	below).	A	more	detailed
outline	on	how	to	perform	a	conformer	search	is	found	in	the	"Optimizing	Geometry"	section	of	this	manual.	Avogadro	only
renders	staggered	conformations,	and	does	not	calculate	ring	conformers.

Calculate	Energy

Conformer	Search
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"Constraints"	is	a	way	to	ensure	atom	stability	in	various	selections	(dialog	box	depicted	below).	The	constraints	that	can	be
applied	to	a	molecule	include	Ignore	Atom,	Fix	Atom,	Fix	Atom	X,	Fix	Atom	Y,	Fix	Atom	Z,	Distance,	Angle,	and	Torsion
Angle.	A	detailed	outline	on	how	to	use	the	constraints	feature	is	found	in	the	"Optimizing	Geometry"	section	of	this	manual.

"Ignore	Selection"	allows	you	to	select	a	specific	part	of	a	molecule	to	omit	during	a	geometry	optimization.

Constraints

Ignore	Selection
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"Fix	Selected	Atoms"	also	allows	you	to	set	a	certain	part	of	a	molecule	to	fix	during	optimization.

Avogadro	provides	you	with	the	ability	to	interface	your	molecules	with	other	dialog	based	plugins.	These	extensions
interact	with	a	molecule	to	provide	further	molecular	information,	and	additional	computation	abilities.	These	plugins	include
but	aren't	limited	to	GAMESS,	Abinit,	Dalton,	GAMESS-UK,	Gaussian,	MOLPRO,	MOPAC.	NWChem,	PSI4,	Q-Chem,	and
LAMMPS.

Avogadro	(as	you	will	see	below)	can	be	used	to	display	molecular	orbitals,	QTAIM,	spectra,	as	well	as	create	various
surfaces.	However,	many	of	these	features	can	not	be	used	to	their	full	potential	without	first	running	one	of	the	plugins
listed	in	the	section	above.	Gaussian	is	one	of	the	most	common	plugins	used,	due	to	it's	wide	range	of	basis
sets/functions.

After	selecting	"Gaussian"	from	the	Extensions	menu,	the	dialog	box	depicted	below	will	appear.	You	can	edit	the	dialog
box	and	add	specific	keywords	to	utilize	these	features	in	Avogadro.	For	example,	typing	"freq"	in	the	dialog	box	will
compute	force	constants	and	vibrational	frequencies.	More	information	on	keywords	for	Gaussian	can	be	found	at	the
Gaussian	website	(http://www.gaussian.com/g_tech/g_ur/l_keywords09.htm).	Then	clicking	generate	will	let	you	save	the
file	to	your	computer,	so	you	can	run	the	file	in	external	software.

Fix	Selected	Atoms

Avogadro	Extensions--Plugins

General	"How	To"	for	Plugins

Running	Gaussian
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Once	the	file	has	been	run	through	the	external	software,	you	will	have	a	.g03	or	.g09	file	that	will	open	the	keyword
selection	in	a	toolbar	on	the	right	hand	side	of	the	screen.	"Freq"	will	open	the	vibrations	toolbar	shown	below.
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The	"Molecular	Orbitals"	selection	will	display	the	molecular	orbitals	for	orbitals	with	full	status	bars.	The	quality	of	the
orbitals	can	be	adjusted	an	reconfigured	if	need	be.	This	feature	only	works	by	running	gaussian	extension	files	(.fchk,
.g03,	.g09,	etc.).

Molecular	Orbitals
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QTAIM	displays	the	implicit	bonding	that	is	theorized	to	take	place	between	the	hydrogens	of	organic	crystals	(the	implicit
bonding	is	conveyed	through	dots).	This	display	type	is	utilized	by	importing	a	.wfn	file	from	the	"QTAIM",	"Molecular	Graph"
selection	under	the	"Extensions"	menu.	Selecting	"Molecular	Graph	with	Lone	Pairs"	or	"Atomic	Charge"	will	provide
concurrent	information	about	the	molecule.	More	information	can	be	found	on	this	process	in	the	Tutorial	section	of	this
manual.

QTAIM	(Quantum	Theory	of	Atoms	in	Molecules)
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Clicking	on	"Spectra..."	will	create	a	spectra	visualization	of	a	.g03,	or	.g09	file	that	has	been	run	with	the	keyword	"freq".	A
spectral	visualization	can	also	be	created	through	the	vibrations	toolbar	by	selecting	"Show	Spectra...".

Spectra...
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"Create	Surfaces..."	allows	you	to	view	the	Van	der	Waals,	Electrostatic	Potential,	Electron	Density,	and	Molecular	Orbital
Surfaces.	The	surface	type	options	for	viewing	depend	on	what	type	of	calculations	have	previously	been	run	on	the
molecule.	The	type	of	file	you	open/create	allows	for	more	or	less	surface	viewing	options	(generally	discussed	under
Avogadro	Extensions--Plugins).	This	feature	also	allows	you	to	edit	the	color,	resolution,	and	iso	value	to	further	enhance
your	surface.

Create	Surfaces...
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Avogadro	comes	equipped	with	multiple	different	force	fields.	Below	is	general	information	regarding	the	force	fields	to	help
you	select	the	best	optimization	method.

UFF	(Universal	Force	Field)	is	capable	of	reproducing	the	most	structural	feature	across	the	periodic	table.	This	force	field
can	optimize	the	geometry	for	all	elements,	and	does	well	with	inorganic	materials,	and	organometallic	materials.

MMFF94	&	MMFF94s	(designed	by	Merck),	is	particularly	good	with	organic	compounds.	MMFF94	has	specifically	been
parameterized	for	alkanes,	alkenes,	alcohols,	phenols,	ethers,	aldehydes,	ketones,	ketals,	acetals,	hemiketals,
hemiacetals,	amines,	amides,	peptide	analogs,	ureas,	imides,	carboxylic	acids,	esters,	carboxylate	anions,	ammonium
cations,	thiols,	mercaptans,	disulfides,	halides	(chlorides	and	fluorides),	imines,	iminium	cations,	amine	N-oxides,
hydroxylamines,	hydroxamic	acids,	amidines,	guanidines,	amidinium	cations,	guanidinium	cations,	imidazolium	cations,
aromatic	hydrocarbons,	and	heteroaromatic	compounds.

MMFF94	and	MMFF94s	use	the	same	functional	form	to	calculate	the	potential	energy.	They	only	differ	in	the	Torsion	and
Out-Of-Plane	bending	parameters	used.	The	's'	in	MMFF94s	stands	for	static	and	this	set	of	parameters	is	more	suited	for
tasks	where	the	output	is	static.

These	force	fields	also	add	electrostatic	charges,	and	hydrogen	bonds	(displayed	below).

Molecular	Mechanics	&	Force	Fields

UFF

MMFF94(s)
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GAFF	(General	AMBER	Force	Field)	is	often	used	for	optimizing	the	geometries	of	drugs.	AMBER	(Assisted	Model	Building
with	Energy	Refinement)	is	a	common	protein	force	field.

GAFF	has	specifically	been	parameterized	for	organic	molecules	made	of	C,	N,	O,	H,	S,	P,	F,	Cl,	Br,	and	I.

GAFF
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How	to	search	for	low-energy	conformations

Before	finding	a	low-energy	conformer,	we	should	make	sure	the	current	geometry	is	at	least	a	near-optimal	geometry.
Perform	an	"Optimize	Geometry"	for	a	quick	clean-up.

Conformers

Start	with	your	molecule	of	interest

Optimize	the	geometry
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Now	we	will	want	to	change	the	force	field	and/or	the	number	of	optimization	steps.

You	may	want	to	change	the	force	field	used.	MMFF94	is	a	good	default	for	organic-like	molecules.	If	the	molecule	contains
metals	or	is	otherwise	unusual,	UFF	is	a	better	choice.	Next,	change	the	number	of	geometry	optimization	steps	—	for	each
conformer	tested,	it	will	be	optimized.	Switch	to	a	small	number	like	20	or	50	for	a	quick	clean-up	to	prevent	"clashing"
atoms	when	bonds	are	rotated.

Change	the	force	field	options

Set	the	conformer	search	options
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1)	Pick	a	search	method.	Systematic	searches	are	exhaustive,	but	will	always	find	the	global	minimum.	A	Weighted	rotor
search	or	Genetic	Algorithm	search	are	preferred.	2)	If	you	pick	a	Weighted	Search,	set	the	number	of	conformers	to	test
(e.g.,	200).	3)	If	you	pick	the	Genetic	Algorithm	search,	set	the	options,	including	the	Energy	scoring	method.	4)	Click	"OK"
to	start	the	search.

Pick	a	search	method	and	start	the	search
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Avogadro	allows	for	the	optimization	of	an	object,	with	respect	to	a	variable(s).	Below	is	one	example	of	how	constraints
can	be	applied	while	optimizing	a	molecule.

Constraints	can	be	applied	to	fix	or	ignore	a	specific	selection	of	atoms	in	a	molecule,	as	well	as	to	fix	distances,	and
angles.	For	additional	information	review	the	"Auto-Optimization	Tool"	and	"The	Extensions	Menu"	sections	of	this	manual.

Let's	say	we	have	a	diene,	that	we	want	to	fix	in	a	cisoid	conformation	before	optimizing	the	geometry	of	the	rest	of	the
molecule	(example	shown	below).	After	drawing	your	molecule,	check	the	label	display	type,	and	click	the	wrench	to	the
right	of	the	name.	Select	the	"Atom	number"	label	form	and	close	the	dialog	box.

This	will	label	all	of	the	atom	indices.

Constraints	&	Optimizations

Constraints

Example
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Before	we	can	apply	the	constraint,	we'll	need	to	figure	out	the	distance	between	atom	3	&	6.	Following	the	procedure
displayed	below,	select	the	measure	tool,	and	then	choose	the	two	atoms	that	you	want	to	apply	a	constraint	to.	This	will
output	a	distance	in	angstroms	at	the	bottom	of	the	screen.
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From	here	go	to	the	"Extensions"	menu,	and	under	"Molecular	Mechanics",	select	"Constraints...".	Then	choose	"Distance",
as	the	type	of	constraint,	enter	in	the	length	(3.092	Å),	and	the	atom	indices.	Select	"Add",	and	then	click	"OK",	to	add	the
constraint	and	close	the	dialog	box.
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Optimizations	can	then	be	applied	to	work	around	the	constraint.	For	more	information	about	force	fields	refer	to	the
"Molecular	Mechanics	and	Force	Fields"	section	of	this	manual.

Now	(post	addition	of	constraint),	Avogadro	will	selectively	keep	the	cisoid	conformation	while	concurrently	adjusting	the
parameters	of	the	other	atoms	in	the	molecule.

Optimizations

Example	cont.
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Avogadro	has	a	new	interface	to	the	open	source	solid-state	code	ABINIT,	provided	by	one	of	the	ABINIT	developers,	Prof.
Matthieu	Verstraete

Start	with	a	crystal	structure	—	here	a	clay	mineral	from	the	new	Avogadro	crystal	library.

ABINIT	Generator
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Open	up	the	Abinit	input	generator	under	the	Extensions	menu

Most	common	options	for	Abinit	are	available	here,	with	a	text	preview	(highlighted	in	red)	generated	as	you	change
options	above.
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The	input	generator	allows	you	to	(1)	pick	the	type	of	coordinates:	real-space	Cartesians	or	reduced	coordinates	and	(2)
pick	the	type	of	geometry	optimization	(if	any).

Another	important	option	is	setting	the	occupation	scheme	(1)	and	SCF	options	(2)	and	(3).

Finally,	when	finished,	you	can	click	the	“Compute”	button	(not	pictured)	if	Abinit	is	available	locally	on	your	computer,	or
“Generate”	to	save	the	input	file	for	submission	to	a	remote	queue.
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Save	the	input	file	and	you‘re	finished!
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The	independently	developed	Packmol	extension	can	be	used	to	generate	a	box	of	water	molecules.

LAMMPS	input	for	water

Prepare	initial	geometry

Open	the	LAMMPS	input	dialog
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1.	 Choose	the	number	of	repeating	units	of	the	input	coordintes	in	x,	y	and	z	directions
2.	 Choose	the	water	potential.	The	current	version	supports	SPC	and	SPC/E	model	potentials
3.	 Choose	the	name	of	LAMMPS	formatted	coordinates.	The	name	will	be	used	in	a	later	step	when	the	lmpdat	file	is

created.
4.	 Choose	the	total	number	of	MD	steps.
5.	 Choose	the	file	name	of	the	XYZ	formatted	trajectory	file.

Prepare	simulation	parameters
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1.	 Click	the	Generate	button
2.	 Choose	a	file	name
3.	 Click	save
4.	 Close	the	input	generator	dialog

1.	 Select	"Save	As"	from	the	file	menu
2.	 Input	the	"water.lmpdat"	file	name	from	above
3.	 Select	"All	files"

Generate	the	LAMMPS	parameters	file

Generate	the	LAMMPS	Coordintes	file
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4.	 Save	the	LAMMPS	formatted	coordinates	file

After	2700	time	steps,	the	temperature	is	begining	to	stabilize.

Run	LAMMPS
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Avogadro	now	includes	support	for	the	QTAIM	analysis	developed	by	Prof.	Richard	Bader	and	his	group.	This	technique
allows	Avogadro	to	determine	bond	connections	and	bond	orders	directly	from	the	quantum	mechanical	electron	density.

Most	quantum	chemistry	software	allows	creating	a	WFN	format	file	from	the	output	of	a	calculation.	We	can	read	this	file	in
through	the	QTAIM	Extension	for	visualization	and	analysis.	In	the	future,	other	formats	will	also	be	supported,	including
deriving	the	data	directly	from	checkpoint	files.

Here	we've	picked	a	WFN	file	of	interest	(HCO2)	using	the	Molecular	Graph	+	Lone	Pairs	command.

Using	Atoms-In-Molecules	(Bader)	Analysis:	QTAIM	and
WFN

Start	with	a	WFN	File
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Avogadro's	QTAIM	support	will	read	in	the	atoms,	determine	bonds	and	bond	orders	using	AIM	analysis	and	then	continue
with	further	analysis.

Initially,	you	may	not	see	anything	different.	QTAIM	includes	a	separate	Display	Type	for	viewing	the	results	of	the	AIM
analysis.

Here,	we've	enabled	the	QTAIM	display,	which	will	show	lone	pairs,	bond	critical	points,	etc.	You	may	also	want	to	turn	off
the	Ball	and	Stick	model	to	see	all	AIM	annotations.
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Here,	we've	also	turned	off	the	classical	ball	and	stick	display	type	to	leave	only	the	QTAIM	view	of	HCO2.
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This	feature	allows	visualizing	vibrations	from	a	"frequency"	calculation	with	quantum	chemistry	codes	(e.g.,	Gaussian,	Q-
Chem,	etc.)

After	opening	an	output	file	that	has	been	run	with	the	keyword	"freq",	the	"Vibrations"	toolbar	will	automatically	open.

This	toolbar	allows	you	to	view	the	various	vibrations	of	a	molecule.	Selecting	a	frequency,	and	clicking	"Start	Animation"
will	begin	a	vibration.

Viewing	Vibrations
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Avogadro	then	provides	you	with	the	ability	to	edit	the	vibration	amplitude,	it	allows	you	to	display	the	force	vectors	on	the
atoms	present,	and	it	allows	you	to	adjust	the	animation	speed	by	the	frequency.
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This	tutorial	covers	plotting	vibrational	spectra,	but	other	types	of	spectra	are	possible	with	the	output	files	from	quantum
chemical	programs

After	opening	an	output	file	that	has	been	run	with	the	keyword	"freq",	the	"Vibrations"	toolbar	will	automatically	open.

Clicking	on	"Show	Spectra..."	in	the	Vibrations	toolbar,	or	selecting	"Spectra..."	under	the	"Extensions"	menu	will	open	a
spectra	visualization	of	the	molecule	(displayed	below).

Viewing	Spectral	Properties

Show	Spectra...
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Selecting	"Advanced>>"	in	the	spectra	visualization	will	allow	you	to	change	the	visual	settings,	as	well	as	the	spectral
settings,	and	export	the	image.

The	"Advanced>>"	selection	provides	a	multitude	of	general	edits	to	use	at	your	convenience.	For	example,	you	can
change	%	transmittance,	to	%	absorbance	(under	Infrared	Spectra	Settings),	and	change	the	scheme	from	dark	to
publication	(Appearance	Settings).
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This	feature	requires	a	"checkpoint"	or	"formatted	checkpoint"	from	quantum	chemistry	codes

When	the	output	file	is	opened,	if	a	matching	checkpoint	file	is	found,	it	automatically	opens	the	Orbitals	toolbar.

All	potential	molecular	orbitals	will	have	full	status	bars	(you	may	need	to	scroll	down	considerably	to	find	the	potential
orbitals).	Clicking	in	the	row	of	an	orbital,	with	a	full	status	bar,	will	create	a	quick	low	quality	rendition	of	the	orbital.

Viewing	Molecular	Orbitals
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A	higher	orbital	quality	can	be	selected	and	applied	if	desired.	This	is	done	by	selecting	a	new	image	quality	from	the	drop
down	menu,	and	clicking	"render".	These	renditions	can	take	a	moment	to	load.
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Selecting	"Configure"	allows	you	to	adjust	the	default	parameters	for	the	orbital	toolbar.	Once	the	parameters	have	been
adjusted,	click	"Recalculate	All"	before	closing	the	dialog	box.	"Recalculate	All"	reevaluates,	and	updates	all	of	the
parameters.

Configure
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The	electrostatic	potential	maps	help	to	visualize	charge	distribution,	and	other	charge	related	properties	of	molecules.

Overall,	let's	say	you	want	to	determine	visually	if	a	specific	proton	has	more	or	less	electron	density.	First,	you'll	want	to
begin	with	your	molecule	of	choice	(shown	below	is	trifluoracetic	acid).

Then	under	the	"Extensions"	menu,	select	"Create	Surfaces...".

Viewing	Electrostatic	Potential	Maps
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A	dialog	box	will	pop	up	providing	you	with	various	surface	options.	Under	"Color	By:"	select	"Electrostatic	Potential",	and
then	click	"Calculate".	After	Avogadro	calculates	the	surface	select	"Close".
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An	electrostatic	surface	has	now	been	created.	From	this	surface,	you	can	interpret	where	the	most	electron	density
resides	(in	the	more	red	areas),	and	where	the	least	electron	density	resides	(deep	blue	areas).	You	can	further	determine,
and	compare	the	acidity	of	various	protons,	and	how	surrounding	atoms	impact	the	overall	electron	density.
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This	example	was	taken	from	"Exploring	the	Acidity	of	Organic	Molecules	with	Avogadro"	written	by	Tamika	Madison.

The	opacity,	rendition,	and	colors	of	the	surface	can	the	be	changed	by	clicking	the	wrench	next	to	the	"Surfaces"	display
type.

Changing	Surface	Settings
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Avogadro	1.1	and	later	includes	support	for	naming	compounds	using	the	NIH	Chemical	Resolver	system	and	the
PubChem	database.

Open	up	the	Molecule	Properties	window,	under	the	View	menu.

The	IUPAC	name	will	initially	show	as	(pending)	while	the	server	returns	the	name,	(unknown)	if	the	molecule	is	not	found
in	the	resolver,	or	(unavailable)	if	your	network	connection	is	down	or	the	resolver	service	is	otherwise	unreachable.

Naming	a	molecule	with	PubChem
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As	you	modify	the	molecule	(e.g.,	adding	a	Cl	atom),	the	name	will	update	automatically	with	the	other	properties.
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